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Chapter 1

Browse Overview

24 October 2008

This section contains the following topics:

e What is Aurora Browse?

»  Components of Aurora Browse

* Logging in to the Aurora Browse client

e Overview of the Aurora Browse window
e Customizing the Aurora Browse window
»  About MediaFrame status

e About Transfer Manager

e About roles
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What is Aurora Browse?

Aurora Browse processes an incoming feed and simultaneously encodes it into two
formats: a low-resolution format stored locally on the Network Attached Storage
(NAS) unit, and a high-resolution format stored on the K2 server.

Aurora Browse creates video thumbnails and storyboards. From your PC, you can
mark in-points and out-points using the low-resolution media. Aurora Browse also
provides a rich metadata search engine that allows you to search for assets using
various criteria. Aurora Browse can also monitor the K2 server to create low-resolution
files that do not exist, and stream live feeds.

From the Aurora Browse application you can archive and restore high-resolution
media. Archived media is still visible from the Aurora Browse application.

Related Links

Logging in to the Aurora Browse client on page 7
Customizing the Aurora Browse window on page 9

About roleson page 11

Components of Aurora Browse

Aurora Browse is a distributed application that runs on multiple, specialized servers.

While installations may differ in that some servers may either be absent or duplicated,
a basic Aurora Browse system consists of the following:

Aurora Browse component

Description

Aurora Browse Client

The user’s component of the Aurora Browse system
is on your own PC. It accesses the Aurora Browse
server.

MediaFrame Server

The central component of the Aurora Browse system
is the Aurora Browse server. It manages the other
system components, manages the metadata database,
and runs the web server to support the Aurora Browse
client on your PC.

Network Attached Storage (NAS)

The NAS unit stores the low-resolution video clips
and video thumbnails.

Advanced Encoder (Aurora Proxy
Encoder)

The Advanced Encoder, also known as the Aurora
Proxy Encoder, creates proxy versions of
high-resolution video assets that already exist or are
actively being recorded on a video server, processes
proxy content and extracts thumbnail images to be
used for proxy identification, extracts dynamic scene
detection images for storyboard creation, and renders
low bitrate proxy content. The Advanced Encoder
processes entirely in the digital domain.

6 Aurora Browse User Manual

24 October 2008



BrowseOverview

Aurora Browse component Description

SmartBin Encoder The SmartBin Encoder is a variant of the Advanced
Encoder, used for non-winking systems (non-shared
storage) in a high-resolution NAS instead of a SAN.

Related Links
Logging in to the Aurora Browse client on page 7
Customizing the Aurora Browse window on page 9
About roles on page 11

Logging in to the Aurora Browse client

You can log into the Aurora Browse client from your PC. You no longer need to access
Aurora Browse via a web-based application.

Before you log in to the Aurora Browse client, make sure your administrator has set
up an account on the MediaFrame server with your username and required roles.

If you PC is configured to use a web proxy and this proxy isn’t available, Aurora
Browse can’t connect to its server. Since using a web proxy affects performance, Grass
Valley recommends not using a web proxy with Aurora Browse.

1. To log in to the application on the Start menu under Programs.

2. Select Grass Valley Aurora Browse | Aurora Browse. Aurora Browse verifies your
settings before the application displays on your PC.

The Aurora Browse application displays.

NOTE: If your administrator upgrades to a later Aurora Browse client version, a dialog
box displays asking you if you want to upgrade the version on your PC. You can continue
on with other tasks while the upgrade is in process. You can also check for updates by
selecting Check for Updates from the Help menu.

Related Links
About roles on page 11
About MediaFrame status on page 10
About Transfer Manager on page 10
Components of Aurora Browse on page 6
What is Aurora Browse? on page 6
Overview of the Aurora Browse window on page 7
Customizing the Aurora Browse window on page 9
About roles on page 11

Overview of the Aurora Browse window

The menus in Aurora Browse are all context dependent; if you right-click on different
views you can see different options depending on your location.

24 October 2008 Aurora Browse User Manual 7
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If you are using the default workspace, then the Aurora Browse window contains three
main panes, or views.

View Description

Asset Navigator view Contains the Search, Explore, and Collections tab. Use the
Search tab to browse logical or physical assets, the Explore
tab to navigate the MDIs and their folders for physical
assets, and the Collections tab to group assets together.

Asset List view Lists all the assets found as a result of a search. The default
limit is 50 assets, but you can increase the limit up to 500
assets returned from a search.

Asset Details view Describes the selected asset in detail, including the
metadata, associations, and if -- if the pane is full size --
all the clip player controls and the storyboard.

g Tip: You can designate a location as a favorite. This creates a shortcut folder
in the Explore tab. Favorites can be local only or global so that all the users on
your network can access them.
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NOTE: A red dot next to an MDI indicates there is no communication with the
MDI, and a green dot indicates the server is communicating with the MDI. If a red
X is displayed against the MDI, the server is communicating with the MDI but the
MDI is experiencing a problem.

Related Links
Logging in to the Aurora Browse client on page 7
Customizing the Aurora Browse window on page 9
About roleson page 11

Customizing the Aurora Browse window

Aurora Browse can be customized to suit your individual needs.

You can choose which columns to display in the Asset List view or in Transfer
Manager. The Asset List, Asset Navigator and Asset Details views are all dockable
and resizable.

Some examples of how you can change the Browse layout include:

» Triggering the autohide feature to hide a view — click on the thumbtack icon in the upper
right-hand corner of the view. A tab with the view’s name on it appears on the side of the
workspace. If you move the mouse to another view, the autohidden view disappears. Moving
the mouse over the tab causes the autohidden view to appear. Clicking again on the
thumbtack icon returns the view to its original location.

* Hiding a view— right click on the blue title bar of a view and select Hide. To bring the
view back, select Window from the File menu. An unchecked view is hidden. Clicking on
the view returns it to its original location.

» Detaching a view—right click on the blue title bar of the view and select Floating. The
view is now separate from the other Browse views. Double-clicking on the blue title bar
returns the view to its original location.

« Moving a view to a different location — drag the blue title bar of a view. Double clicking
on the blue title bar restores the view to its original location.

» Changing the columns displayed in the Asset List view or in Transfer Manager —right-click
on one of the column names and select which columns to view.

* Viewing thumbnails in the Asset List view — click the Search tab and right-click in the
Asset List view. The thumbnails option displays.

» Sorting the list — click on the column you want to sort by.
e Change the display to thumbnail view — right-click on a column name.
* You can save your changes in a workspace (Window | Workspace | Save Workspace).

You can also delete a workspace or return to the default workspace.
Related Links
Logging in to the Aurora Browse client on page 7
About MediaFrame status on page 10
About Transfer Manager on page 10
Components of Aurora Browse on page 6
What is Aurora Browse? on page 6

24 October 2008 Aurora Browse User Manual 9



BrowseOverview

10

Overview of the Aurora Browse window on page 7

About MediaFrame status

The MediaFrame Status tabs, located under the Tools menu, provide about the status

of Browse, your user settings, licensing, and version information.

All this information can be saved to a log and used to help troubleshoot any issues
that might arise.

MediaFrame Description
component
Status & Log Lists the current status of all the interfaces between the Aurora

Browse server and the Aurora Browse client application on your
PC. For more information on Transfer Manager, select Tools |
Transfer Manager from the main menu. Detailed information on
how to configure the other MediaFrame components can be found
in the Aurora Browse Installation and Configuration Guide. Green
dot: connected Grey dot: not in use Red dot: error Amber dot:

warning
Licensing Lists all the roles you have been licensed for
User Settings Lists all your individual and global settings
\ersions Lists the versions of all the different components
About Lists the version of the Browse client application

Related Links
Logging in to the Aurora Browse client on page 7
Customizing the Aurora Browse window on page 9
About roles on page 11

About Transfer Manager

Transfer Manager tracks the status of all the transfers made in your Aurora Browse
system.

Some ways you can customize Transfer Manager include:

* Filtering the list of transfer jobs

» Specifying which columns you want displayed

» Using the drop-down lists to view only transfers in specific states or queues, or
transfers made by specific users

The Reset button lets you reload the contents of Transfer Manager.
Related Links
Logging in to the Aurora Browse client on page 7

Aurora Browse User Manual
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Customizing the Aurora Browse window on page 9
About roles on page 11

Transfer options

When you transfer an asset, a dialog box displays with transfer options. You can edit
or delete these transfer options from the main menu, under Tools.

About roles

Roles allow you to view and use different parts of the Aurora Browse program.

Your administrator will determine which roles you require.

Archive Browse Browse Browse Encoder Media Restore Transfer

Role Edit logging View role Manager role role
role role role role
Add or X
delete
custom
metadata
fields
Archive X x!
Browse for X X X X X X
video assets
Create, X
delete,
rename, or
copy an
archive and
subfolders
Edit X X
metadata
Encode X X2
proxies
ExploreMDI X X X X X X
devices for
video assets
LD editing X X

1

If you have the Media Manager role and need to archive, you must have the archive role as well.

2 f you have the Media Manager role and need to create proxies, you must have the encoder role as well.

24 October 2008
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Archive Browse Browse Browse Encoder Media Restore Transfer
Role Edit logging View role Manager role role
role role role role

Partially X
restore
archive

Only for
SGL
(Flashnet
MDI)

Restore X3 X
archive

Search for X X X X X X
video assets

Transfer x4 X
assets from

one online

MDI device

to another

Related Links
Logging in to the Aurora Browse client on page 7

Logging in to the Aurora Browse client on page 7
About MediaFrame status on page 10

About Transfer Manager on page 10

Components of Aurora Browse on page 6

What is Aurora Browse? on page 6

Overview of the Aurora Browse window on page 7

3 f you have the Media Manager role and need to restore, you must have the archive role as well.
4f you have the Media Manager role and need to transfer an asset, you must have the transfer role as well.
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Chapter 2

Search

This section contains the following topics:

* Quick Reference: searching for assets

»  Shortcutsto assets, locations, or searches

e Searching for an asset by name

e Searching for an exact phrase

e Searching with wildcards

»  Searchicon reference table

* Saving asearch

e About searching with filters

*  About favoritefilters

» Creating afilter

» Filter icon reference table

e About searching metadata fields

e Searching with Boolean operators (AND, OR, AND NOT)
*  Searching for numbers

»  About noise words: words ignored in a search
e Searching with noise words
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Quick Reference: searching for assets

To search: Follow these steps:

For logical In the Asset Navigator view, under Advanced settings, select the Search in

assets drop-down field. Specify the MediaFrame database and press the Search button.
MediaFrame database searches return logical assets that contain metadata and
links to any physical assets including high-resolution media and proxy video.

For In the Asset Navigator view, under Advanced settings, select the Search in
physical drop-down field. Specify the MDI device and press the Search button. MDI
assets device searches return physical assets. If a red X is displayed against the MDI,

the system is communicating with the MDI but the MDI is experiencing a
problem. A red dot indicates there is no communication with the MDI, and a
green dot indicates the server is communicating with the MDI.

Using Create a filter and use it to search: In the Asset Navigator view, click the down
specific arrow next to Advanced Settings. The Advanced Settings dialog box displays.
criteria, Click the Add Filter icon and select the Property and Comparison criteria from
such as the drop-down lists. Click OK to add the newly created filter to the active filter
searching list. Press the Search button.

Z?;;L%S Notes: You can create an unlimited number of filters and save them as

part of a search. You can use filters as independent search criteria or use

f . o -
Esrgiia them together with a text search. If more than one filter is defined, an
date AND operator is implied between them.
Using only Under Advanced Settings, select the MediaFrame database or an MDI device.
specific In the Fields drop-down list, check the field or fields to search on and press the
metadata  Search button.
fields
Using text  Enter the search criteria in the Asset Name text field and press the Search button.
or numbers ) . . .
in the name Notes: Do not use wildcards or quotation marks in the Asset Name text

field. Do not enter more than one word unless you are searching for an

of the asset exact match of the multiple words and spaces.

Using text  Enter the search criteria in the Asset Metadata text field and press the Search
or numbers button.

in the ) . . .
metadata  1NOtes: You can use wildcards or quotation marks in the Asset Metadata

fields of the [EXt field. If you enter more than one word or phrase, the OR operator is

asset implied unless you specify otherwise.

Related Links
Searching with noise words on page 24
Searching with Boolean operators (AND, OR, AND NOT) on page 22
Searching for numbers on page 23
Searching for an asset by name on page 16
Searching with wildcards on page 17
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Searching for an exact phrase on page 16

Saving a search on page 18

Creating a filter on page 20

About favorite filters on page 19

About searching with filters on page 19

About noise words: wordsignored in a search on page 23
About searching metadata fields on page 21

Shortcuts to assets, locations, or searches

To do this
task:

Follow these steps:

Create a
collection for
frequently
used assets

Select the Collections tab. Select File | New Collections or press Ctrl + N.
Enter the collection information and click OK. Notes: You can create
collections for logical or physical assets. When you create a collection, you
can make it private or shared, temporary or permanent. Temporary collections
are deleted when you close your Browse session.

Create a

shortcut to
frequently
used assets

In the list of assets, right-click on the asset you want to add to your collection.
Select Add to collection and specify the collection or create a new collection.
To view the asset, click the Collections tab and click on your collection.
Notes: Putting an asset into a collection does not move the asset; it creates a
reference that points to the original asset. Therefore, deleting a collection
does not affect the assets that were inside the collection bin. If you see a red
X next to an asset reference, Browse was unable to retrieve information about
that asset. The asset might have been deleted.

Create a
shortcut to a
frequently
used folder

Select the Explore tab and navigate to the folder you want to create a shortcut
for. Right-click on the folder and select Add to Favorites or Add to Global
Favorites. Notes: Creating a shortcut to a frequently used folder is also helpful
when you want to archive an asset to that folder. Global changes are saved
to the server when you close down your Browse session. Other users need to
open a new Browse session before they can see the changes.

Find a saved
search or
return to the
default search

Click the drop-down arrow below Asset Navigator (immediately below the
File menu) and select the search you want to use.

Find the
location of a
physical asset

If you have a logical asset with a physical asset associated with it, and you
want to quickly find which MDI device holds this asset: Right click on the
physical asset name and select Synchronize. The Explore tab appears in the
Asset Navigator view with the folder highlighted.

Related Links

Searching with noise words on page 24
Searching with Boolean operators (AND, OR, AND NOT) on page 22
Searching for numbers on page 23

24 October 2008
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Searching for an asset by name on page 16

Searching with wildcards on page 17

Searching for an exact phrase on page 16

Saving a search on page 18

Creating a filter on page 20

About favorite filters on page 19

About searching with filters on page 19

About noise words: words ignored in a search on page 23
About searching metadata fields on page 21

Searching for an asset by name

Do not enter more than one word in the Asset Name text field unless you want to find
both words exactly as typed with spaces.

NOTE: The Asset Name field does not recognize quotation marks.

To search for an asset by name, enter text or numbers in the Asset Name text field
and click the Search button.

Results are returned from assets that contain the search term in the name of the asset,
even if it is a fragment of the name.

Related Links
About favorite filters on page 19
About searching with filters on page 19
About noise words: words ignored in a search on page 23
About searching metadata fields on page 21
Shortcuts to assets, locations, or searches on page 15
Quick Reference: searching for assetson page 14
Filter icon reference table on page 21
Search icon reference table on page 17

Searching for an exact phrase

How you search for an exact phrase depends on whether you’re entering the search
term in the Asset Name or the Asset Metadata text field.

NOTE: The Asset Name field does not recognize quotation marks.

» If you search within the Asset Metadata text field, enter the phrase in quotation
marks.
» |If you search within the Asset Name text field, enter the exact phrase.

Related Links
About favorite filters on page 19
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About searching with filters on page 19

About noise words: words ignored in a search on page 23
About searching metadata fields on page 21

Shortcuts to assets, locations, or searches on page 15
Quick Reference: searching for assets on page 14

Filter icon reference table on page 21

Search icon reference table on page 17

Searching with wildcards

Wildcard searches can be performed in the Asset Metadata field.You can only use an
asterisk at the end of a term, not in the beginning or middle.

If you want to search using a beginning fragment of a term, use the wildcard asterisk
symbol (*) in the Asset Metadata text field.

Using an asterisk after a term returns any asset that contains the term, followed by a
space or by more text, in any of the text fields.

NOTE: To search using a fragment that is found in the middle or the end of a word in the
asset metadata, add a filter under Advanced Settings instead using the Asset Text or Asset
Metadata text field.

Related Links

About favorite filters on page 19

About searching with filters on page 19

About noise words: words ignored in a search on page 23
About searching metadata fields on page 21

Shortcuts to assets, locations, or searches on page 15
Quick Reference: searching for assets on page 14

Filter icon reference table on page 21

Search icon reference table on page 17

Search icon reference table

Icon Description

Displays the name of the current search, if any.

Saves search criteria, either globally or locally.

% Deletes the current search.

¥ Sets the current search to be the default search.

Aurora Browse User Manual
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Related

Saving

Related

Icon Description

o Resets the default search.

2 Undoes the default search reset.

2 Indicates a search saved locally on a PC.
Indicates a search saved globally.
Indicates a default search (installed with the application, cannot
be modified).

Links

Searching with noise words on page 24

Searching with Boolean operators (AND, OR, AND NOT) on page 22
Searching for numbers on page 23

Searching for an asset by name on page 16

Searching with wildcards on page 17

Searching for an exact phrase on page 16

Saving a search on page 18

Creating a filter on page 20

About favorite filters on page 19

About searching with filters on page 19

About noise words: words ignored in a search on page 23
About searching metadata fields on page 21

a search

You can create a customized search that searches specifically for particular text or
properties.

1. Enter your search criteria.
2. Under Asset Navigator, click the Add Saved Search icon |g.

3. Name the search, and if desired make the search accessible globally. You cannot
give a search the same name as one of the default searches (which are indicated
by a lock icon).

NOTE: Searches can be saved globally for universal access, or locally for your access only.
Global changes are saved to the server when you close down your session. Other users need
to open a new session before they can see the changes.

Links

About favorite filters on page 19

About searching with filters on page 19

About noise words: words ignored in a search on page 23
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About searching metadata fields on page 21
Shortcuts to assets, locations, or searches on page 15
Quick Reference: searching for assets on page 14
Filter icon reference table on page 21

Search icon reference table on page 17

About searching with filters

Using a filter, you can search assets by name, description, or other specific criteria.
You can also use a filter if you are searching for a fragment of metadata.

You can also use a filter in conjunction with text in the asset name or asset metadata
text fields. If you search using a text field and a filter, only assets that have the search
term and meet the specified criteria are returned.

You can create an unlimited number of filters and save them as part of a search. Filters
can be used as independent search criteria or together with a text search that uses
Boolean operators, fragments of asset names, or other asset metadata.

If more than one filter is defined, an AND operator is implied between them.
Related Links

Searching with noise words on page 24

Searching with Boolean operators (AND, OR, AND NOT) on page 22

Searching for numbers on page 23

Searching for an asset by name on page 16

Searching with wildcards on page 17

Searching for an exact phrase on page 16

Saving a search on page 18

Creating a filter on page 20

Shortcuts to assets, locations, or searches on page 15

Quick Reference: searching for assets on page 14

Filter icon reference table on page 21

Search icon reference table on page 17

About favorite filters

When you create a filter, you can add it to your list of favorite filters. This allows you
to quickly access the filters.

The favorite filters are only accessible on the PC where they were created, but they
are available regardless of which search you are using.

Related Links
Searching with noise words on page 24
Searching with Boolean operators (AND, OR, AND NOT) on page 22
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Searching for numbers on page 23

Searching for an asset by name on page 16
Searching with wildcards on page 17

Searching for an exact phrase on page 16

Saving a search on page 18

Creating afilter on page 20

Shortcuts to assets, locations, or searches on page 15
Quick Reference: searching for assets on page 14
Filter icon reference table on page 21

Search icon reference table on page 17

Creating a filter

Filters let you customize your searches so that you can quickly locate specific assets.

1. In the Asset Navigator view, click the double arrow or the plus sign next to
Advanced Settings. (Which icon is displayed is determined by the length of the
search pane.)

The Advanced Settings dialog box displays.
2. Click the Add Filter icon | .

The Add Filter dialog box displays.
3. Select the Property and Comparison criteria from the drop-down lists.
4. 1f you want to use this filter frequently, check the Add to Favorites box.

If you want to delete the filter from the Favorites list later, you can select Modify
Favorites.

5. Click ok to add the newly created filter to the active filter list.
6. Press the Search button.

The new filter is displayed in the Filters field.
Related Links
About favorite filters on page 19
About searching with filters on page 19
About noise words: wordsignored in a search on page 23
About searching metadata fields on page 21
Shortcuts to assets, locations, or searches on page 15
Quick Reference: searching for assets on page 14
Filter icon reference table on page 21
Search icon reference table on page 17
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Filter icon reference table

The following table describes the Filter icons.

Icon Description

Creates a new filter

2

Displays favorite filters

-

Modifies a created filter

B

Deletes the selected filter.

X

Related Links

Searching with noise words on page 24

Searching with Boolean operators (AND, OR, AND NOT) on page 22
Searching for numbers on page 23

Searching for an asset by name on page 16

Searching with wildcards on page 17

Searching for an exact phrase on page 16

Saving a search on page 18

Creating a filter on page 20

About favorite filters on page 19

About searching with filters on page 19

About noise words: words ignored in a search on page 23
About searching metadata fields on page 21

About searching metadata fields

You can limit your search to specific metadata fields or keywords, such as the asset
name, the source ID or a keyword, by using the asset metadata text field and specifying
the fields to search.

Assets are returned if they have the word or phrase in any of the specified metadata
fields.
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NOTE: To search foreign metadata or keywords, you need to select these fields in
the Filters drop-down list.

Related Links

Searching with noise words on page 24

Searching with Boolean operators (AND, OR, AND NOT) on page 22
Searching for numbers on page 23

Searching for an asset by name on page 16
Searching with wildcards on page 17

Searching for an exact phrase on page 16

Saving a search on page 18

Creating a filter on page 20

Shortcuts to assets, locations, or searches on page 15
Quick Reference: searching for assets on page 14
Filter icon reference table on page 21

Search icon reference table on page 17

Searching with Boolean operators (AND, OR, AND NOT)

You can search with the following Boolean operators: AND, OR, and AND NOT. If
you enter more than one term without a specific Boolean operator, the OR operator
is implied.

To search with Boolean operators, use the Asset Metadata text field.

NOTE: You cannot search with explicit Boolean operators in the Asset Name text field.
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Related Links

About favorite filters on page 19

About searching with filters on page 19

About noise words: words ignored in a search on page 23
About searching metadata fields on page 21

Shortcuts to assets, locations, or searches on page 15
Quick Reference: searching for assets on page 14

Filter icon reference table on page 21

Search icon reference table on page 17

Searching for numbers

You can search for numbers in three ways:

e To find a number in the asset’s name, use the Asset Name text field.
* To find a number in the asset’s metadata, use the Asset Metadata text field.

» To find a number only in a specific category, such as a specific Creation Date,
Modification Date, etc., create a filter and select the property to search on.

NOTE: You cannot search for single numbers in the Asset Metadata text field. Any single
character, letter or number, is treated like a “noise” word and is ignored. To search for a
single number in the metadata, create a filter.

Related Links

About favorite filters on page 19

About searching with filters on page 19

About noise words; words ignored in a search on page 23
About searching metadata fields on page 21

Shortcuts to assets, locations, or searches on page 15
Quick Reference: searching for assets on page 14

Filter icon reference table on page 21

Search icon reference table on page 17

About noise words: words ignored in a search

Certain “noise” words or characters are automatically ignored in a search in the Asset
Metadata text field.

Examples include:

» Prepositions or articles (such as “after”, “before”, “the”, “an”, etc.)
* single characters or numbers (“a” “z”, “0”, “9”, “$”, “_”, etc.)
e pronouns (“who”, “him”, “mine”, etc.)

e common verbs (such as “will”, “said”, “want”, etc.)
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Related Links
Searching with noise words on page 24
Searching with Boolean operators (AND, OR, AND NOT) on page 22
Searching for numbers on page 23
Searching for an asset by name on page 16
Searching with wildcards on page 17
Searching for an exact phrase on page 16
Saving a search on page 18
Creating afilter on page 20
Shortcuts to assets, locations, or searches on page 15
Quick Reference: searching for assets on page 14
Filter icon reference table on page 21
Search icon reference table on page 17

Searching with noise words

To search for noise words, create a filter containing the word or words you want
to search for.

PR
. =T

If you have administrator privileges, you can modify the SQL file containing the noise
words. Modifying this list might affect expected execution times.

Related Links
About favorite filters on page 19
About searching with filters on page 19
About noise words; words ignored in a search on page 23
About searching metadata fields on page 21
Shortcuts to assets, locations, or searches on page 15
Quick Reference: searching for assets on page 14
Filter icon reference table on page 21
Search icon reference table on page 17
About noise words; words ignored in a search on page 23
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Chapter 3

Edit

This section contains the following topics:

* About the clip player
* Playing an asset

» Trimming assets

e Managing proxies

e About the storyboard
* Using the storyboard
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About the clip player

In the Asset Details view, you can perform the following tasks:

» Play through the selected asset using the transport controls to manage normal speed
play

» Create Mark In and Out points

e Trim the asset

» Toggle the timecode control track

» Use the slider to scrub the media

» See the table below for a description of each control.

Tip: If you do not see all of the transport controls, try resizing the Asset Details
view horizontally. If you don’t see storyboard elements below the clip player,
try resizing the Asset Details view vertically. You might also want to verify a

| A
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storyboard proxy is listed as one of the asset’s associations in the Asset Details
view.

Number Description

1 Creates a Mark In point at the current frame. The timecode of the Mark In point
is displayed to the left.

2 Shows the location in the asset being played. Drag the slider to scrub through the
asset.

3 Toggles the timecode control track. Control track lets you see the actual count of

an asset instead of using timecode. This is valuable for easily calculating duration
while setting mark points.

4 Clears the Mark In and Mark Out points

(6]

A storyboard element. When you select a storyboard element, an eye icon displays
in the upper left-hand corner.

6 Moves the asset back one frame

7 Jogs the asset back ten frames

8 Rewinds the asset

9 Plays the asset from the start

10 Plays the asset from the location of the slider.

11 Shows the timecode of the current location in the asset

12 Stops the playing of the asset

13 Fast forward

14 Jogs the asset forward ten frames

15 Moves the asset forward one frame

16 Reloads the current asset

17 Toggles loop playback

18 Creates a Mark Out point at the current frame. The timecode of the Mark Out
point is displayed to the right.

19 Toggles loop playback

20 Scrolls forward or backward. Click and drag to the left or the right side to scroll
through the asset frame by frame.

21 Indicator light turns red when the proxy of an asset is being created.

22 Creates a Mark Out point at the current frame. The timecode of the Mark Out

point is displayed to the right.

Related Links
Using the storyboard on page 29
Copying an asset on page 33
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Managing proxies on page 28

Playing an asset on page 28
Trimming assets on page 28

Browse keyboard shortcuts on page 48

Playing an asset

» To play an asset, double-click on the asset in the Asset List view.

In the Asset Details view, a thumbnail of the asset displays in the clip player with
metadata on the right side of the pane.

NOTE: If you hover the mouse indicator over an icon, a tooltip appears describing its
function. Once you have clicked on an icon, the tooltip no longer appears.

Related Links
About the clip player on page 26
Browse keyboard shortcuts on page 48

Trimming assets

To trim an asset:

1. Double-click on the asset in the Asset List view. The asset displays in the Asset
Details view.

2. Press the Play button or use the slider to navigate to the point where you want to
trim.

3. Adjust the mark points to trim the asset:

* Click Mark In to adjust a mark in point.
» Click Mark out to adjust a mark out point.

4. Adjust the Mark In or Mark Out points as needed.

The Mark In and Mark Out timecodes display the new trimmed start and stop points.
Related Links

About the clip player on page 26

Browse keyboard shortcuts on page 48

Managing proxies

If you have the appropriate permissions, you can create or regenerate a proxy for an
asset.

» To create or re-create a proxy, right-click on the physical asset and select create
proxy Or recreate proxy.
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Related Links
About the clip player on page 26
Browse keyboard shortcuts on page 48

About the storyboard

A storyboard displays video thumbnails of scene changes in the asset, providing an
easy way to see what the asset includes.

If you right-click on a storyboard element, you can:

» Set the storyboard element as a thumbnail
» Create a keyword

e Set Mark In and Mark Out points

e Copy to clipboard

Related Links
Using the storyboard on page 29

Using the storyboard

» To view the asset from a specific spot, click a storyboard image.

An icon of an eye displays in the upper left-hand corner of the storyboard, and the
clip player positions the playback pointer at the selected frame.

Related Links
About the storyboard on page 29
About the clip player on page 26
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Chapter 4

ManagingAssetsFolders

24 October 2008

This section contains the following topics:

» Creating a new folder

» Deleting an asset or a folder

» Deleting one asset from the archive
e Renaming an asset or a folder

* Copying an asset
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Creating a new folder

To create a new folder, do the following:

1. Navigate to a location in which creating a new folder is allowed.

2. Do one of the following:

* Right-click in the location and select New.
* Click File | New folder.

The folder appears.

Deleting an asset or a folder

If deleting a folder, you must first delete all the assets in that folder.

To delete an asset or a folder, do one of the following:

» Right-click an asset or a folder and select Delete.
» Select an asset or a folder and click Edit | Delete.

The asset or folder is deleted.

Deleting one asset from the archive

This procedure describes removing a single asset from the archive. You cannot use a

batch operation to remove more than one asset from the archive at a time.

Aurora Browse lets you store your assets on a permanent archive, thus allowing you

to remove high-resolution material from your K2 storage that you don’t need for
immediate playout. After some period of time, you might decide that you no longer

need to keep material on the archive, or you might want to remove the original version

of an asset and store a modified version instead. You can selectively remove assets

from the archive without affecting the online high-resolution material on the K2 server.

NOTE: Ifyou see a red X by the asset reference, Browse was unable to retrieve information

about that asset. The asset might have been deleted.

To delete a single asset:

1. Locate the asset you want to delete from the archive.
2. Right-click and select Delete.

A confirmation message displays.
3. Click Yes.
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NOTE: Archive assets that do not have corresponding high-resolution media on the server
appear in the Asset List view with only an orange dot in the Location column. Deleting these
assets from the archive removes that last high-resolution copy of the asset.

You can observe the status of the Delete operation and error messages, if any, by
selecting Tools | Transfer Manager from the main menu.

Renaming an asset or a folder

Browse renames the components of the asset that can be renamed, and displays a
warning message about the components that cannot be renamed.

You can name an asset if it is online and hasn’t been archived If an asset is online and
also archived, you cannot rename the archived asset.

NOTE: when naming an asset, use only US ASCII characters. Do not include the left angle
bracket (<), right angle bracket (>), back slash (\), forward slash (/), colon (:), asterisk (*),
question mark (?), double quote (), pipe symbol (|), percent symbol (%), left bracket (]),
right bracket (1), or underscore (_) in the name.

To rename an asset or a folder, do one of the following:

* Right-click an asset or a folder and select Rename.
» Select an asset or a folder and click Edit | Rename.

The name of the asset or folder becomes editable. Modify the name and then press
Enter or click off the name to put the change into effect.

Copying an asset

NOTE: You can also use Copy to paste metadata such as the asset's name, creation date
and duration into a text application such as Notepad.

To copy an asset to a new location, do the following:

1. Select the asset in the Asset List view.
2. Right-click and select Copy or Copy To.

3. If you selected Copy, click the Explore tab and navigate to the location where you
want to copy the asset. If you selected Copy To, a dialog box displays. Navigate to
the location where you want to copy the asset.

g~ Tip: If you copy assets to a particular folder frequently, you can save
time if you add the folder to your personal favorites.

4. Right-click on the destination folder and select Paste.

5. A dialog box displays Transfer Options. You can specify an automatic rename if
the asset has the same name as another asset in the folder. Click oK.

Related Links
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About the clip player on page 26
Browse keyboard shortcuts on page 48
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This section contains the following topics:

e About metadata

»  About general metadata

» Adding General Information

e Adding keywords

e Adding keyframes

* Deleting keywords

» Exporting keywords as a K2 playlist
* Managing custom metadata fields

e Using custom metadata fields

*  Printing metadata
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About metadata

Metadata is data about data; it can include keywords, timecode information, and other
terms that help you find a particular asset.

Metadata adds descriptive information about media assets. An administrator can create
customized, predefined metadata fields to speed selection and avoid errors. You can
enter information in custom metadata fields before, during, or after assets are ingested.
You can also print metadata.

Once metadata has been entered into the Aurora system, it is searchable and you can
use it to locate the specific assets recorded at that time.

The types of metadata featured in Aurora Browse are described in the following table.

Type of Description
metadata

Core Certain metadata brought in through Aurora Ingest, such as Name, Creation
Date, Description Field and Keywords appear in Browse with high-resolution
associations. Likewise certain metadata added in Aurora Edit as part of Master
Clips and Sequences also get added to Browse environment for a common
metadata view. An administrator can customize and expand mapping depending
on your workflow requirements.

Custom Metadata in fields that have been created by an administrator. Custom metadata
can include text fields, as well as date, number, or Boolean fields.

Logical Metadata about a logical asset, that is, metadata about the MediaFrame database
asset information, physical asset or assets on the server, and proxy assets.

Physical Metadata about a physical asset, or essence, is metadata about raw program
asset material, such as video or audio.

About general metadata

The following table describes the components of the General metadata tab.

Component Description

Thumbnail The still image of the frame that the general metadata describes. To change
the thumbnail, right click on the image.

Name The asset name. If the asset has been located using Search, the name is
highlighted.

Source The name of the advanced encoder that encoded the proxy.

Expires Hold Enter an expiration date If the date field is not defined, click the drop-down

Duration arrow to bring up a calendar and select a date. If a date has already been

entered, you can modify it by typing a new date in the Expires field. Check
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Component Description
the hold box if you don't want the asset to expire. The asset cannot be
deleted until the hold box is unchecked. The duration indicates the length
of the asset.

Description Click in the Description text field to enter text, if desired. If you press

Enter after adding a description, you will see [] symbols immediately
after the word in the Description column of the Asset list.

Search Terms

Additional search information.

Add, delete, or add options to custom metadata fields.

Print the general metadata.

Undo the metadata change.

Redo the metadata change.

Adding General Information

You can add general information about an asset to make it easier to find.

1. To add general information to an asset, load the asset.
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The asset displays in the clip player, and the General metadata tab is displayed.
If you located the asset using a search, the search term is highlighted.

2. In the General metadata area, enter the information.

Adding keywords

Keywords reference a specific timecode location in the media file; they provide a
powerful way to find specific assets.

To add keywords:

1. Create an In point by playing the footage and clicking s} Mark In at the starting
point for the keyword.

2. Create an Out point by clicking E Mark Out at the end point for the keyword.

3. In the Clip Player, select the Keyword tab.

4. Click the Keyword drop-down list and select Keyword.
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The new keyword displays.
5. To change the name of the keyword, double click on the default keyword name
and press Enter.

The keyword is added to the list.

Adding auto-mark keywords

You can define how newly created keywords or keyframes are hamed using the
Keyword Options dialog box.

1. Inthe Core Metadata view, select the Keywords tab.
2. Click the Keyword Options icon, next to the Mark In and Mark Out fields.

The Keyword Options dialog box displays.
3. To automatically generate keyword names, check the Auto-Generate keyword
names box and fill in the text field.
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Once the option is checked, keywords are created using the defined naming rule.
(Optionally, you can use "%" to specify where the numbering will be placed.)
If the option is not checked, the default keyword name, keyword , is used with
an incremental suffix.

Adding keyframes
A keyframe is a zero-length keyword.

Rather than being created from the currently selected mark-in and mark-out points, a
keyframe is created at the clip player’s current play position. Selecting a keyframe
moves the clip player’s current position to that location, but it doesn’t modify the
mark-in or mark-out points.

To add zero-length keywords, press the Insert key.

The keyframe displays as a notch, similar to a storyboard marker.

Deleting keywords

» To delete a keyword, highlight the keyword and click the Delete icon .

NOTE: Deleting the material between the Mark In and Mark Out points does not delete the
keyword. Instead, it moves the keyword’s Mark In and Mark Out points to the asset’s original
timecodes.

Exporting keywords as a K2 playlist

You can export a selection of keywords; these keywords can be imported into a K2
system as a playlist.

1. Select the asset. The primary physical asset must be a K2 movie, and a keyframe
(zero-duration keyword) must not be one of the selected keyword entries.

2. Right-click on the asset and select K2 playlist file. (This selection is not visible
unless the primary physical asset associated with the logical asset is a K2 movie.)

3. Save the playlist and click oK.

Managing custom metadata fields

If you have MediaManager privileges, you can add, edit, or delete custom metadata
fields.

To add a custom metadata field, follow these steps:
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1. Load the asset.

In the Asset Details view, the clip player displays.
2. In the Custom tab, click the Manage Fields icon.

The Edit Custom Metadata Fields dialog box displays.
3. Click Add.

The Add Custom Metadata field displays.

4. Once the metadata field has been added, you can add options to the fields, if desired.
The Up and Down arrows let you select a metadata field to modify with options
or to delete the field.

5. Once you have finished managing the metadata fields, click Close.

The new field is displayed in the Field column.

Using custom metadata fields

Custom fields allow you to enter additional asset metadata such as names, air dates,
or source locations.

An administrator can create custom metadata fields.
1. Add values to the custom fields by one of the following methods:

» Select a choice from a drop-down list
» Type the data into the field

 [fthe custom field is a date field, click in the date area and then pick the correct
date on the calendar

2. Click Accept Changes.

The field data is associated with the asset.

Printing metadata

» To print the metadata from the General, Keywords, or Custom tabs, click the Print
icon.
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Transfer

This section contains the following topics:

»  About archiving assets
* Archiving or transferring an asset
* Restoring an archived asset
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About archiving assets

You can store your assets on a permanent archive, thus allowing you to remove
high-resolution material from your server that you don’t need for immediate playout.

You can also transfer assets from one online MDI device to another. You can archive
or transfer a single asset or several assets at once.

Whether you archive or transfer an asset depends on where you are copying or moving
the asset to an offline or an online location. The procedure is the same.

NOTE: A Logical Asset can include references to more than one physical asset
(e.g., an online asset on a K2 server as well as an archived copy of the same asset).
In that case, only the primary physical asset (the first online asset listed) is
transferred.

Related Links
Archiving or transferring an asset on page 44
Partially restoring an asset on page 46
Restoring an archived asset on page 45

Archiving or transferring an asset

Whether you archive or transfer an asset depends on where you are copying or moving
the asset to an offline or an online location; the procedure is the same.

g~ Tip: Ifyou plan to archive or transfer assets frequently to the same folder, add that
- folder to your favorites. This creates a shortcut in the menu, allowing you to select that
folder directly from the menu instead of browsing to the transfer location.

To archive or transfer an asset:

1. Inthe Asset List view, select the asset. To select multiple assets, hold down Ctrl
while you select the assets.

2. Right-click and select Move To. (If you prefer to, you can select Copy To and
delete the asset after it is moved.)

* Online: transfers the asset to another MDI device.
e Offline: archives the asset.

NOTE: For the K2 BaseCamp Express, only the near-line storage is available
as an archive destination.

» Browse: lets you navigate to a local archive/transfer destination.

3. If you have added the destination folder to your favorites, select that folder from
the drop-down list. Otherwise, select Browse and navigate to the destination folder.

4. If you are transferring an asset, skip to step 7.
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If you are archiving an asset, the Transfer Options dialog box displays.
5. Select a priority from the drop-down list.

6. If desired, check the box asking to automatically rename the archived asset if the
name already exists in the archive and click OK.

NOTE: You cannot archive two assets with the same name.

While an archive or transfer is pending, an icon of rotating multi-colored dots
displays in the upper right-hand corner.

7. From the main menu, select Tools | Transfer Manager. The Transfer Manager allows
you to track the progress of your archives or transfers.

g~ Tip: If you want to change the transfer settings later, select Tools | Transfer
Options from the main menu.

Upon completion of the archive operation, the Location column in the Asset List or
Thumbnail view shows the status of the asset.

NOTE: The Asset List view is not immediately refreshed. You can perform a search for the
asset to verify its status.

The asset’s status appears as follows:

» Online: a green dot displays in the Location column.
» Offline (archived) but not deleted: the Location column shows a green dot and an orange
dot in the Location column.

« Offline (archived) and deleted: an orange dot displays on the Location column in the List
and the Thumbnail view on the Search tab.

NOTE: You can verify the status of your archive operation, and error messages, if any, by
Tools | Transfer Manager from the main menu.

Related Links

About archiving assets on page 44

Restoring an archived asset

Aurora Browse lets you store your assets on a permanent archive, thus allowing you
to remove high-resolution material from your server that you don’t need for immediate
playout. As needed, you can restore archived material to the server for use.

These procedures describe completely or partially restoring a single asset. You can
also restore several assets in a single operation.

To restore an asset:

1. Select the asset to be restored. To restore multiple assets, hold down ctrl and select
the assets.
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In the Location column of the Asset List view, an orange dot indicates the asset
is archived.

2. Right-click on the asset. Select Copy To or Move To and the folder where you
want to transfer the high-resolution material on your News MDI or K2 server.

» If you select Move To, the asset is deleted from the archive.

» |f you select Copy To, the asset is kept online as well as being saved offline
(archived).

NOTE: For K2 BaseCamp Express, only the K2 server will be available as a
restore destination.

3. If you do not want to overwrite an existing asset with the restored asset, modify
the restored asset's name.

a) Select Tools | Transfer Manager from the main menu.

b) Check the box asking to automatically rename the restored asset if the name
already exists in the transfer destination and click oK.

Related Links
About archiving assets on page 44

Partially restoring an asset

A partially restored asset uses the originally created proxy.

To partially restore an asset:

1. Load a logical asset
2. Set the Mark In and Mark Out points in the Clip Player.

3. Right-click in the clip player and select Partial Copy To | Online, and select the
location where you want to restore the asset.

Upon completion of the restore operation, the Location column of the online asset
displays a green dot next to the asset on the server.

NOTE: Remember that restore operations are not always immediate. You can verify the
status of your restore operation, the names of the assets that are restored, and error messages,
if any, by selecting Tools | Transfer Manager from the main menu.

Related Links
About archiving assets on page 44
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Keyboard Shortcuts

This section contains the following topics:

»  Browse keyboard shortcuts
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Browse keyboard shortcuts

This table lists the keyboard functions that control the Aurora Browse clip player.

Function Key
Copy Ctrl -C
Cut Ctrl-X
Paste Ctrl-vV
Rename Ctrl-R
Delete Del
Move Up Ctrl-Up
Move Down Ctrl-Down
Mark In Ctrl-1or |
Mark Out Ctrl-Oor O
Create Keyword F3

Auto Keyword F4

Add Keyframe Insert
Refresh F5
Create Proxy Ctrl-Y
Synchronize Ctrl-H
Subclip Ctrl-B
Trim Ctrl-T
Remove from collection Ctrl-F
Add to new collection Ctrl-G
Add to personal favorites Ctrl-K
Audio settings Ctrl-A
Add to storyboard Ctrl-S
Select All Ctrl-A
Deselect Ctrl-D
Play/Stop Spacebar
Play W
Rewind E
Fastforward R

Back 1 frame A
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Function Key
Fwd 1 frame S
Back 10 frames D
Forward 10 frames F
Play from start Q

Related Links
Copying an asset on page 33
Managing proxies on page 28
Playing an asset on page 28
Trimming assets on page 28
About the clip player on page 26

24 October 2008 Aurora Browse User Manual 49






Glossary

24 October 2008

ASK

The central registry for all the MediaFrame components. Other software components
refer to the ASK component to establish communication and exchange commands
and data as well as populate fields and lists.

Asset

See Logical Asset and Physical Asset.

Asset Details

The MediaFrame view that contains detailed information about the assets, including
all the associated metadata and storyboard and video proxy information.

Asset List

The MediaFrame view that lists all the assets in a search or a folder.

Asset Navigator

The MediaFrame view that is used for searching logical assets or browsing for physical
assets.

Device

In Aurora Browse, a term used to designate a component that contains physical asset.
Devices have MDIs that represent the device’s assets in a way that is understandable
by the other components of the system. This allows the MediaFrame server to
coordinate the activity of the system. Different devices perform different functions in
the MediaFrame system. For example, the K2 MDI device is used for transferring
assets, while the News MDI is used for Aurora Edit assets and the Flashnet (SGL)
MDI is used for archiving assets.

Essence

See Physical asset.

FTP

File Transfer Protocol is a common IT protocol for the bulk movement or transfer of
large volumes of data. K2 servers can handle multiple FTP transfers simultaneously
at faster than real-time speeds.

HD
High Definition video.
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Logical Asset

A logical asset is a combination of the MediaFrame database information, physical
asset or assets on the server, and proxy assets. A logical asset has a globally unique
Universal resource Name (URN) that uniquely identifies it.

Material

A high-resolution clip, upon which the low-resolution proxy is based.

MDI

Managed Device Interface.

MediaFrame

A metadata storage and asset management architecture deployed in the Aurora suite.
This architecture shares media asset management (MAM) components with other
applications and systems such as servers, Aurora Ingest, and Aurora Edit workstations.

MediaFrame Status

A tool in Aurora Browse that tracks the status of the various components of Aurora
Browse.

Metadata

Data about data. For example, metadata can include keywords, descriptions, and other
terms that you would use to search for an asset in a database.

Offline

In Aurora Browse, offline refers to an asset that has been archived.An asset can be
both offline and online simultaneously.

Online

In Aurora Browse, online refers to an asset that is located on the high-resolution server.
An asset can be both offline and online simultaneously.

Physical Asset

A physical asset, or essence, is the raw program material, represented by pictures,
sound, text video, etc. It carries the actual message or information.

Proxy

A low-resolution clip that represents high-resolution material.

SD

Standard Definition video.
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Storyboard

A series of video thumbnails used to show scene changes in an asset.

Storyboard proxy

The low-resolution video clip that provides the thumbnails for the storyboard.

Subclip

A clip created by referencing a portion of media from another clip.

Thumbnail

A frame of video used for visual identification of a clip. By default, the thumbnail is
generated in the K2 server from the 16th frame of video. You can select a new
thumbnail using the Storyboard.

Thumbnail view

The MediaFrame view that shows the Asset List information with thumbnails instead
of strictly textual information.

Transfer Monitor

A tool in Aurora Browse that monitors asset transfers.

Up Conversion

Conversion of an SD (standard definition) video format to an HD ((high definition)
video format.
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